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Digital Asset Management User Guide

The Digital Asset Management module of the Nuxeo Platform provides organizations
with an application to manage their multimedia resources, from capture to delivery.

Like any other module of the Nuxeo Platform, Digital Asset Management (DAM) is a
web application, so users don't need to install anything on their computer to access it.
They just need a web browser (IE 7 or +, Firefox etc.).

You're new to Digital Asset Management? Take a look at our overview of the DAM
features!

Nuxeo
In this user guide you will learn how to use the DAM module, so that you can:

This short screencast ?IVES a short overview, with a product demonstration, of

Nuxe6 DAMOthé §pbATHaiE tigayvisdens, ri‘i%x%jérﬁé‘ﬁ!@olutlon

Search and consult the assets you need
Edit the metadata of one or multiple assets
Annotate documents

Comment assets

Export assets for delivery

Download

Download this documentation in PDF.

Nuxeo's DAM module User Guide Content

® Digital Asset Management Concepts
® Working with digital assets

® Importing assets in DAM
Browsing and searching assets
Consulting and editing assets
Commenting assets
Annotating assets
Exporting assets

® Supported File Formats
® Managing Nuxeo DAM

® Users & Groups

® Managing access rights

Digital Asset Management Concepts

The Digital Asset Management module of the Nuxeo Platform is dedicated to storing, indexing,
archiving, and distributing digital assets. Beside the Platform minimal features, you get a new
environment specifically designed to ease the management of multimedia assets. Depending on the
other modules you may have installed, you can get other additional features that will take place in
their own environment.
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On this page

® Digital assets

® Available spaces
® Digital Asset Management interface presentation
® Document management environment

Digital assets

The digital assets supported by the DAM module are:

® pictures
® videos
® audio files

But it also supports Office and PDF documents, that you may need with your digital assets.

The whole list of file formats and the available actions are listed in the Supported File Formats page.

Available spaces

The minimal installation of the DAM module provides main tabs on top the of the page, that give access to different environments.

®* The Home tab is where the user can find all the information that concern him: his dashboard to get a quick access to documents, and
that he can customize with internal and external gadgets, the summary of his notification subscriptions, see his profile, etc.

®* The Document Management tab from which the user can work on contents other than digital assets and manage the asset folders. This
is the tab selected by default when the user logs in.

®* The DAM tab from which he'll be able to import and browse assets. This tab enables an environment specifically designed for this kind of

content.
= ome Do 0 DA do
Pl import | Clear filters l:‘
Keywords

Library A :_‘;:‘ R '
e |
All documents ¥ = é ]
Office file g .

Image

Administrators have two extra tabs:

®* The Admin Center tab, from which they can manage the application.
® The Studio tab, which provides access to Nuxeo Studio, the online customization and configuration environment.

=L ome Do 2 anageme DA Ad ente dig Ad
F} Import | Clear filters l:'
Keywords
Library # :_-_- L

(7
All documents ¥ ! £ ! T e
Office file g .

lmane

Digital Asset Management interface presentation

The Digital Asset Management (DAM) user interface is designed for a search-based navigation in the assets lists. A list of filters is available, that
you use to find assets.

The user interface is divided in three parts, as shown below:
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nuxeo Home Document Management SDAMN jdoe
= i E Der tdit | Information [P rights--Export{-History
Keywords [l montage-nuxeo-platform-5.5-background-atomium.png
i
Library A
All documents.
Office file
e montag...um.png montag...ge.png montag...es.png
Video size 506 KB size 355 KB size 521 KB
Sound
Selected folder A
Platform login page proposals
My last imports A |
John Doe - 20120207 12:04
Topic A
Li s ]
| ¥ Daily life == | . |
| Human scien i =
|| Society B -
5 Technology montag...ty.png montag...bz. montag...eg.png
size 261 KB size 299 K8 size 86 KB
Coverage — A —)
|1 | Africa
| Antarctica
Lol Asia
|/ AustraliajOceania
[ europe Main data Edft
2 iy LT i ey T = Title  montage-nuxeo-platform-5.5-background-
Li South America m :; i 1 o atomium.png
rorn e - [~ B S s
between m montag...es.png montag...um.png montag...us.png Authoring date
Lina - size 352 KB size 231 KB size 825 KB Nature
Subjects
Rights
Source
Coverage

1. On the left of the screen are the filtering options that enable you to search assets and narrow the results which are displayed in the center
of the page.

2. The central main part of the screen is where the asset thumbnails are displayed so you can easily see the assets available.

3. The right part of the screen is dedicated to displaying the information of the selected asset: its metadata, a preview of the asset, the IP
rights, the asset's history and the export options.

Document management environment

As a module of the Nuxeo Platform, DAM benefits from its standards document management features, accessible from the Document
Management tab.
The Document Management tab gives access to two domains: the Default Domain and the Asset Library.

The Default domain is the Nuxeo Platform default environment, from which users can create documents and publish them.

The Asset Library is where all the assets imported in DAM are stored. It is organized in folders, which contain the different import sets. You can
benefit from the document management features on assets from the Asset Library.

Working with digital assets

The DAM module of the Nuxeo Platform enables you to manage digital assets (pictures, video and audio files).
After importing files in DAM, users can either consult them, comment them, annotate them or even edit them. Finally, they can export them or
send their reference for delivery.

Here are the pages where you can find information to work with digital assets:
® Importing assets in DAM

Browsing and searching assets

Consulting and editing assets

Commenting assets

Annotating assets

Exporting assets

Supported File Formats

Importing assets in DAM

Assets are imported in folders. You can import either single digital files or a set of files in a zipped folder. In both cases, an import set that holds
the assets is created in the target folder. You can use this import set to find the assets again. Folders can contains several import sets.

You need to have Write permission on at least one folder to be able to import assets in DAM.
To import assets in DAM:

1. In the left pane of the DAM tab, click on the Import button on top the filters.
The "Import Set Creation" window is displayed.

2. Select the file (zip or single digital file) to import. When you click on Select File, a pop-up allows to browse your drives. For large files, the
percent of upload progress is shown.

Copyright © 2010-2016 Nuxeo.
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Import Set Creation

1. Select a file to import

textures.zip
Done

3. Add main metadata

Importset name Nuxeo Textures

Description Internal for brachures

Author Nuxea

Authoring date 12/10/2011

Coverage North America j

United States of America

El

Nuxeo Digital Asset Management 5.5 Documentation Center

2. Select a destination folder

% Clear All Import folder

New Folder
Backgrounds
Craphic Design
lcons

Clear Folder Title

Visuals

Language

Subjects Daily life
Human science
Society

Technology

Current selection:

= Technology/IT

Create Cancel

the name of your import set.

Electronic
Energy
Industry
IT

Select the folder in which the assets are imported.
@ If you choose new folder, type the name of the new folder.
Fill in the main metadata that will be applied to all the assets of the set (see below for information on the import set metadata).

Click on the Create button.
Once the import is done, you can see the digital files as thumbnails, with the first file selected on the right side of the window.

nuxeo Home Document Management BDAMY jdoe
m = [ Information | IP rights | Export | History
Keywords K 4 12 b 107325896_cfOfbbc9dF_o.jpg
5
Library A
All documents
Office file
Image
Video :
Sound 107325..._0.pg 109726...-1.jog 116371..._b.ng
by Nuxeo by Nuxeo by Nuxeo
elecied.folder A1 | size 151 k8 size 1 MB size 350 KB
Nuxeo textures
My last imports A
Nuxeo textures
John Doe - 20120207 12:04
Topic A
| An -—
i pailylife
| Human science
i Sodety :
_j | Technology 120155..._d.jpg 127595..._0.ipg 147520..._b.jpg
by Nuxeo by Nuxeo by Nuxeo
Coverage Al siesss ke size 330 K8 size 226 KB
|| Africa
| Antarctica
| | Asia
|| Australia/Oceania ~ Main data s
_i|_| Europe Title  107325896_cf0fbbedd_o.jpg
a North America Description  Internal for brochures
| South America Original author  Nuxeo
falatineiatias = Authoring date
Nature
between - Subjects  Technology/IT
152011..._0.pg 153834..._o.jpa “R.J ;’
and by Nuxeo by Nuxeo ights
size 613 KB size 153 K8 Source
Coverage
Created ar 3/1/2012 10:27 AM

Import set metadata

Field

Import set name

Description

Author

Description

Name of the set of assets you are importing.

Default import set name is composed of your name and the date and
time. For instance: "John Doe - 20100729 11:09". You can change
this default name.

A textual description of the import set content.
Name of the person who created the content of this import set

(photographer, graphic artist, name of a company or organization,
etc.)

Copyright © 2010-2016 Nuxeo.
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Authoring date

Coverage

Language

Topic

Nuxeo Digital Asset Management 5.5 Documentation Center

Date at which the content was created

Geographic or temporal coverage of the resource, the geographic
applicability of the resource, or the jurisdiction under which the

resource is relevant.
Language used for the assets

Subject(s) of the assets in the import set

@ This is the default product metadata set, that can be adapted to your own properties.

Browsing and searching assets

Navigation in DAM is based on search and filters. By default, all the assets of the folders you can
access (ie in which you have at least Read rights). The principle is to narrow down the search results
and so the assets displayed.

The search available is a full text search. Assets are indexed using their title, description, content (+
attached files), and metadata. You can also use filters. The available filters are:

Coverage

Library: the different asset types
Selected folder: the folder in which assets are imported
My last imports: your import sets
Topic: the subjects assigned to the assets

Authoring date

On this page

® Finding assets using keywords
® Finding assets using the library filter
® Finding assets using metadata filters

Finding assets using keywords

Full text search uses stemming. The Stemming search option will return the assets containing words that have the same stem as the word you

entered into the "Keywords" field.
If you enter the world "Reading", you will find the assets containing in their text metadata "Read", "reads" etc.
This is not the same thing as a search with a wildcard like "*".

The following example shows all the assets. There are 4 pages of results.

nuxeo

lar iters

Keywords
é
Library
All documents
Office file
Image
Video
Sound
Selacted folder
All documents
My last imports.
John Doe - 20120305 17:07
John Doe - 20120301 17:33
DM Product Tour Part 1
Topic
Art
Dally life
Hurman science
Society
Technology

{1 Ty Iy I )

Coverage
Africa
Antarctica
Asia
Australia/Oceania
Europe
North America

[ T R T T

South America
Authoring date
between

and

http://localhost:8080/nuxeo/#

Home Document Management

107325..._o.jpg
by Nuxeo
size 151 KB

116371...]
by Nuxeo
size 350 KB

127595..._0.jpg
by Nuxeo
size 339 kB

DAM

Jdoe

109726...-1jpg
by Nuxeo
size 1 MB

b.ipg 120155..._d.jpg
by Nuxeo
size 466 KB

|

132340..._d.jpg
by Nuxeo
size 5 MB

Information | IP rights | Export | History
107325896_cfOfbbcddr o.jpg

112302..._d.jpg
by Nuxeo
size 3 MB

123626..._0.jpg
by Nuxeo
size 133 KB

~ Main data Edit

Title  107325896_cf0fbbcddf_o.jpg
Description  Internal for brochures
Original author  Nuxeo
Authoring date
Nature

Subjects  Technology/IT
Rights
Source

Coverage

Created as

141525..._0.jpg
by Nuxeo
size 60 KB

3/1/2012 10:27 AM

Suppose that you would like to narrow down the results to few assets, and you are looking for an illustration of a blue item.

1. On the search pane, in the "Keywords" text area, enter the search term "blue".

@ The full text search field will trigger the search 1 second after you wrote the letters in the field.

Copyright © 2010-2016 Nuxeo.
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The results will be the assets containing the word "blue", "BLUE", "BlUe" or any other combination of uppercase and lowercase letters:
This search is not case sensitive.
The search results will be filtered and will show only the digital files in which the word "blue" can be found:

nuxeo Home Document Management NDAMN jdoe

m I:‘ D D Information | IP rights | Export | History

107325896 _cf0fbbcadf_o.jpg

Keywords

4o blue
Library A
All documents
Office file

(T2 107325..._0.jpg 112302..._d.jpg 116371..._b.jpg
Video by Nuxeo by Nuxeo by Nuxeo
Sound size 151 K8 size 3 M8 size 350 K8
Selected folder A
Al documents
My last imports. A
John Doe - 20120305 17:07
John Doe - 20120301 17:33
DM Product Tour Part 1

Topic A
Ly At =
| Dallylife
o Human science 120155..._d.jpg 141761..._d.jpg 152011..._o.jpg
i sodiety by Nuxeo by Nuxeo by Nuxeo

8 size 466 KB size 3 MB size 613 KB

a Technology

Coverage A
| Africa
1 Antarctica
| Asia - Main data Edt
1 Australia/Oceania Title  107325896_cf0fbbeddf_o.jpg
a Europe Description  Internal for brochures
_j | North America Original author Nuxeo
_j | South America Authoring date

T a| 153834.._cipg 219500..._0.ipg 346139..._b.ipg Nature

by Nuxeo by Nuxeo by Nuxeo Subjects  Technology/IT
[ size 153 KB size 112 KB size 106 KB Rights
and Source
Coverage
http://localhost: BOBO/nuxeo/# Created at  3/1/2012 10:27 AM

2. Add a word in the "Keyword" full text search field, "water" for example. You will find all the assets containing in their text metadata, both
"blue" AND "water", but not necessarily in that order. This will probably narrow down the search results.

nuxeo Home Document Management SDAMN jdoe

m Clear filters Information | IP rights | Export | History

Keywords 116371729_258b8368db_b.jpg

blue water
Library A
All documents
Office file
Image 116371..._b.jpg 120155..._d.jpg 152011..._o.jpg
Video by Nuxeo by Nuxeo by Nuxeo
Sound size 350 KB size 466 KB size 613 KB
Selected folder A
All documents
My last imports A
John Doe - 20120305 17:07
John Doe - 20120301 17:33

e

DM Product Tour Part 1

Topic A
| An
| Dailylife = |
_j | Human science 389970..._0.jpg 940866..._d.jpg
4 Sodiety by Nuxeo by Nuxeo

size 401 KB size 303 KB

| Technalogy

Coverage A
L Africa
i | Antarctica
D= aeia ~ Main data Edit
a Australia/Oceania Title 116371729 _258b8368db_b.jpg
i Europe Description  Internal for brochures
_J | North America Original author Nuxeo
a South America Authoring date

Authoring date A Nature

Subjects  Technology/IT
between ] Rights
and Source
Coverage

Created at  3/1/2012 10:27 AM

Finding assets using the library filter

This search filter allows to filter and display only one type of asset among:

® Office documents (PDF, MSO or Ooo files)
® Images

® Videos

® Audio

This search criterion can be combined with the other following criteria, to build a search query with the AND operator.

In the following example, results will be images or audio files with the word "blue” in their metadata. There won't be videos or office files:

Copyright © 2010-2016 Nuxeo.
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Keywords
olue
Library 2
All documents
Office file
Image
Video
Sound

o

Finding assets using metadata filters

To refine your search, you can use following metadata of the assets: Coverage, Topic, Authoring date. Select one or more of these criteria to
narrow down the assets displayed.

Here is an example using Coverage filter:

1. You want to find the pictures, with "blue", that were taken in the US. In the "Coverage" tree, click on "North America", and then on "United
States of America".
The search results will be filtered accordingly.

nuxeo Home Document Management SDAMN jdoe
I:‘ D D Information | IP rights | Export | History
Keywords 112302125_4b480f2f82_o_d.jpg
4O blue
Library A
All documents =
Office file i e
Image 112302..._d.ipg 141761..._d.jpg 153834..._o.jpg
Video by Nuxeo by Nuxeo by Nuxeo
Sound size 3 MB size 3 MB size 153 KB
Selected folder A

All documents.
My last imports. A
John Doe - 20120306 11:57
John Doe - 20120306 11:55
John Doe - 20120306 11:54

Topic A
il Art
| Dalylife
_j | Human science 359613... d.jpg
i Soclety B ot
a Technology
Coverage A
| Africa
1| Antarctica
T o 2 ~ Main data Edt
1 Australia/Oceania Title 112302125_4b480f2f82_o_d.jpg
a Europe Description  Possible backgrounds for Nuxeo content
= North America Original author  Nuxeo
|- Anguilla Authoring date
|- Antigua and Barbuda Nature
[} Aruba Subjects
[) Bahamas Rights
B) sarbades Source )
- - Coverage North America/United States of America
=] Belize

Created at  3/1/2012 3:34 PM

2. Now, you hesitate between choosing a picture of New York, or a picture from the UK. Add a new geographical coverage location in the
tree by clicking on "Europe" > "United Kingdom of Great Britain and N. Ireland" entry in that tree.
The results will show pictures whose coverage is the US OR the UK:

Copyright © 2010-2016 Nuxeo.
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nuxeo Home Document Management SDAME doe

m Information | IP rights | Export | History

Keywords 112302125_4b480f2f82_o_d.jpg
blue

Library A
All documents
Office file
Image 112302..._d.jpg 141761..._d.jpg 153834..._o.jpg
Video by Nuxeo by Nuxeo by Nuxeo
Sound size 3 MB size 3 MB size 153 KB

Selacted folder A
All documents

My last imports. A
John Doe - 20120306 11:57
John Doe - 20120306 11:55
John Doe - 20120306 11:54

y

Topic A
L3 Art
4 | Dalylife
i Human science 359613..._d.jpg 458559..._0.j
i sodiety by Nuxeo by Nuxeo
8 size 1001 KB size 1 MB
5 Technolegy
Caverage A
o Africa
i | Antarctica
G Asia ~ Main data
& AustraliafOceania Title 112302125 _4b480f2f82_o_d.jpg
i | Europe Description  Possible backgrounds for Nuxeo content
= Aland Islands Original author Nuxeo
| Albania Authoring date
|~ Andorra Nature
|- Austria Subjects
|| Belarus Rights
|2/ Belgium Source
Coverage North America/United States of America
javascript:showFancyBox('/nuxeo nxdoc /default/0432e . b6cd5e97b/preview_popup?conversationid=0NXMAINL'); Created ar  3/1/2012 3:34 PM

3. Click again on the entry "United States of America".
This criterion is removed from the search. You only see the assets that concerns the UK:

nuxeo Home Document Management PDAMN jdoe

[ 1ot | cia e

Keywords 458559024_518faff7ae_o.jpg

Information | IP rights | Export | History

blue
Library Ll
All documents
Office file
Image 458559..._0.jpg
Video by Nuxeo
Sound size 1 MB
Selected folder A
All documents
My last imports A
John Doe - 20120306 11:57
John Doe - 20120306 11:55
John Doe - 20120306 11:54

&

Topic il
|| At
_j_ Daily life
4 Human science
1 Society
~j | Technology
Coverage A
3| Africa
| Antarctica
I oo ~ Main data Edic
| AustraliajOceania Title 458550024_518faff7ae_o,jpg
= Europe Description  Possible backgrounds for Nuxeo content
= Aland Islands Original author Nuxeo
2| Albania Authoring date
|~ Andorra Nature
|- Austria Subjects
|| Belarus Rights
Bl sclgium Source
- Coverage E‘urop‘e,‘lzl.niled Kingdom of Great Britain &

Consulting and editing assets

This page describes the information available on different assets types, and how to consult and edit

them.

On this page

® Consulting assets

Consulting a picture and office documents

® Consulting a video asset

® Main Metadata

® |PTC and EXIF metadata

® |P (Intellectual Property) Rights
[ ]

History

® Editing an asset's metadata

Consulting assets

Users can see assets when they have at least "Read" permission on the folder in which the asset is located.

Consulting a picture and office documents

Copyright © 2010-2016 Nuxeo.
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When you browse and search a picture, you just need to click on it to preview it on the right column of the page and consult its metadata. Click on
the picture's preview to see the full size version.

Consulting a video asset

When a video is imported, thumbnails that segment the video are automatically created to constitute a storyboard.

You can view the chapter you were looking for by clicking on the corresponding thumbnail.The video will play in the preview, starting at the image
you selected.

Information | IP rights | Export | History

Sunset Video 1.mpé

Storyboard

Main Metadata

The Information pane shows the main metadata, which were patrtially filled in when you imported the resources. Some of the asset's metadata are
automaticalluy filled in by the system.

Copyright © 2010-2016 Nuxeo.
This documentation is published under Creative Common BY-SA license. More details on the Nuxeo Documentation License page. 11


http://doc.nuxeo.com/x/GATF

NU22ZLe O Nuxeo Digital Asset Management 5.5 Documentation Center

Information | IP rights | Export | History |
107325896_cf0fbbc9df o.jpg

+ Main data Edit

Title

107325896 _cf0fbbeSdf_o.jpg

Description  Internal for brochures
Original author Nuxeo
Authoring date
Nature
Subjects Technology/IT
Rights
Source
Coverage
Created at 3/1/2012 10:27 AM
Last modified at  3/1/2012 10:27 AM
Format
Language
Expiration date
Author John Doe
Contributors John Doe
and
system
Last contributor  system
Size 151KB

Width 2256 px
Height 1496 px

Title Description
Title Name of the asset, displayed under the preview
Description Description of the asset

Original Author

Person who created the asset, manually indicated when the asset
was imported.

Nature Type of the asset, selected in a list

Subject Topic(s) of the asset

Rights Information about the reproduction rights of the document. Detailed
rights are available in the IP Rights tab of the asset.

Coverage Geographic or temporal coverage of the resource, the geographic

applicability of the resource, or the jurisdiction under which the
resource is relevant

Copyright © 2010-2016 Nuxeo.
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Created at

Last modified at
Format
Language
Expiration date

Author

Contributors

Last contributor

Size
Height
Width

Duration

IPTC and EXIF metadata

Nuxeo Digital Asset Management 5.5 Documentation Center

Date automatically filled in by the system when the asset is imported.
Date automatically filled in by the system when the asset is modified.
Format of the asset, if any is preferred

Language of the asset

End of the asset's validity

User who imported the document. This field is automatically filled in
by the system. The author can be different from the original author.

Users who modified the asset. This field is automatically filled in by
the system.

Last user who modified the asset. This field is automatically filled in
and updated by the system.

Size of the asset
Height of the full size asset
Width of the full size asset

Duration of the video and audio assets. This is only displayed on
video and audio assets.

When assets are imported, the system extracts the metadata embedded in the resource if it exists:

® EXIF (Exchangeable image file format) is a specification for the image file format used by digital cameras.
® |PTC defines a set of metadata attributes that can be applied to text, images and other media types.
These metadata are displayed in the Information pane and cannot be edited.

Copyright © 2010-2016 Nuxeo.
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Infermation | IP rights | Export | History

35961302 c681511cd5_o_d.jpg

b Main data Edit
+ Comments (0) Add
+ EXIF
Date 5/12/2005
width 1280
Height 898

Orientation TOP_LEFT
Equipment Canon Canon PowerShot 530
F-Number 5.6
Exposure time (s) 1/1000
150

= IPTC

Filename WY/NE Sunrise &
Headline
Keywords

Date created 5/13/2005
Country
Province/State NE
City
Caption  Early morning in westernmost Mebraska. Just
left I-80 and heading south on Hwy 61.

By line pfly
By line title
Copyright
Credit Line pfly

Source

Writer  pfly

IP (Intellectual Property) Rights

Assets also have an IP Rights tab, in which you can specify permissions for use of the file.

You can specify geographical restrictions for broadcast, copyright, Creative Commons Licence, embargo and expiration date.

@ The embargo and expiration date are only informative fields, there is no automatic process on those dates.

Copyright © 2010-2016 Nuxeo.
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Information | IP rights | Export | History

Intellectual property rights Save | | Cancel
Media type Print j
Geographical . N . -
broadcast United States of America J
Copyright holder
Licence CCRY j

Embargo date 3/1/2012

Expiration date 3/31/2012

More details about Creative Commons licenses &7

History

The History tab shows the actions performed on the asset since its creation.
You can see the kind of action that was done, who performed each action, the date and hour of the action, and the life cycle state of the document

during the action.

Information | IP rights | Export | History

Event log

Action Date Time Username State
Modification 3/1/2012 16:03  John Smith Project
Modification 2/7/2012 12:05 system Project
Creation 2/7/2012 12:05 system Project

Editing an asset's metadata

You need to have at least "Write" permission to be able to edit the properties of an asset and enrich it.
When you edit an asset, you can modify its main metadata and its IP rights.

1 The size, height, width and duration information are not editable.

To edit an asset:

1. Click on an asset to preview it and see its metadata.
2. In the Information pane, click on the Edit button of the Main data.
3. Edit the information you wish.
4. Click on the Save button.
The new values are saved. The asset's history is updated and the fact that you edited the asset is tracked.
5. Click on the IP Rights tab if you want to edit them.
6. Click on the Edit button.
7. Update the Intellectual properties information.
8. Click on the button Save.

The new values are saved. The asset's history is updated and the fact that you edited the asset is tracked.

@ The Main metadata can also be edited from the Document Management view.

Commenting assets

Comments enable users to discuss the asset and its evolution.

You can view comments that have been added to the digital file, with the date and author of the comments, and add your own comments.

Adding a comment on an asset

To add a comment on an asset:

1. In the information tab, in the Comments section, click on the Add button.
2. Fillin the text area with your comment.

Copyright © 2010-2016 Nuxeo.
This documentation is published under Creative Common BY-SA license. More details on the Nuxeo Documentation License page. 15


http://doc.nuxeo.com/x/GATF
https://doc.nuxeo.com/display/DMDOC55/Editing+content

NU22ZLe O Nuxeo Digital Asset Management 5.5 Documentation Center

Infermatian | IP rig hts| ExpDrt| Histl:tr',.rl
342312136_370d55¢c1c8_0.jpg

» Main data Edit

» Comments (1) Add | [ Cancel

3/12/2012 - John Smith wrote:
I like this texture: we should use it for the next Nuxeo World brochure!

v EXIF
v IPFTC

3. Clicking "Add".
Your comment can now be consulted with the asset.

» Comments (2) Add

3/12/2012 - John Smith wrote:
| like this texture: we should use it for the next Nuxeo World brochure!

3/12/2012 - John Doe wrote: (Delete)

Yes, we'll review it at the next marketing meeting.

Deleting a comment

Only the author of the comment and users with Management permission can delete the comments of a document.

(D Deleting a comment is a permanent action. You cannot restore deleted comments.

Copyright © 2010-2016 Nuxeo.
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To delete a comment:

1. Click on Comments in the Information pane of the asset.

2. Click on the Delete link displayed in the top right corner of the comment.
The comment is immediately erased.

Annotating assets

You can annotate pictures and text in DAM.

You can add annotations on all the assets that you can see (i.e. you have "Read" permission).

On this page

® Annotating a picture
® Annotating a document

Annotating a picture
To add an annotation on a picture:
1. To access to the image view, just click on the picture's preview, on the right part of the screen.
A pop up opens.

2. You can zoom in, zoom out, and move within the picture thanks to the tiling feature, that enables visualization of very big pictures on your
screen. To use this feature, move the yellow frame in the thumbnail on the bottom right of the pop up.

Content

. Hide annotations

Content

. Hide annotations

Submit Cancel

4. Once you click on Submit, the annotation is saved.
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Then, you can see your annotation when the mouse is over the zone you selected, and, in the margin, the list of annotations, and for
each, the author, date and time of annotation and the text.

Content

©4 Hide annotations

@& 31212 jdoe

= 31212 jsmith

& 31212 - jsmith

Nice view of the bridge! We should think about it for a
background

= 312112 - jsmith

Nice view of the bridge! We should think.
about it for a background.

Annotating a document

You can preview an office document, and review all the pages. You can also annotate it.

The process is exactly the same as for picture annotation: On the document preview, select text instead of part of a picture. A pop up will allow
you to write your annotation.

Content @ MuxeoDM-Product overview_en.pdf

Files  There are no files attached to this document.
. . 10 geal wiln tné exXplosive volume 01 €1ecironic aata createa oy inrorma-
%, Hide annotations P Y
tion workers.

must allow different collaborators working online

to store content, ensuring is both reliable and

nent with NEXEOIDM

which has been specifcally designed to provide

Submit = Cancel ve electronic document management. It offers the

IUIUwWiny teatuies nauvely:

* Management of Access rights

* Collaboration
* Document annotation

= Version management

Once you click on Submit, the annotation is saved.
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Content E:I MNuxeoDM-Product overview_en.pdf

Files  There are no files atiached to this document.
=, Hide annotations Document management must allow different collaborators working online
to consult, to enrich and to store content, ensuring is both reliable and

= 312
= L audited.

@ 312112 « jdoe

1.2 Document Management with Nuxeo DM

Terminalogy 16 be updated in the whole document

Nuxeo DM is a platform which has been specifcally designed to provide
solutions for collaborative electronic document management. It offers the
following features natively:

* Management of Access rights

+ Collaboration

+ Document annotation

+ Version management

+ Classifcation of document items

+ Metadata management

You can see it when the mouse is over the text, or in the left margin.

Content @I NuxeoDM-Product overview_en.pdf

Files  There are no files attached to this document.
£, Hide annotations to deal with the explosive volume of electronic data created by informa-
tion workers.

=/ 31212 jdoe : ) )
Document management must allow different collaborators working online

5 to consult, to enrich and to store content, ensuring is both reliable and
@ 3112112 + jdoe

audited.

Terminalogy to be updaled in the whole dosurment

1.2 Document Management with Nuxeo DM

= amznz2 - jdoe

Nuxeo DM is a platform which has been spec
solutions for collaborative electronic docume  tarminclagy to be updated in the whale
. . document
following features natively:
* Management of Access rights
* Collaboration

* Document annotation

* Version management

Exporting assets

There are several ways to export your assets:
® Exporting assets individually
® Sending a link to download the asset

Exporting assets individually
Assets have an Export tab, from which you can export the asset.
For pictures, you may be able to select the size of the exported file:

® original: size of the imported picture
® medium: 550 px for height or width
® thumbnail: 100px for height or width

@ The original and medium pictures can be the same size when you download them if the original is smaller or equal to medium size.

To export the asset:

1. Click on the Export tab of the asset.
2. For pictures, select the export size from the drop down list.
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3. Click on the button Download.

Information | IP rights | Export | History

URL
Original http://localhost:8080/nuxeo/nxpicsfile,
Medium | p41h/ flocalhost:8080/nuxeo/nxpicsfile,
Thumbnail | hetn: / flocalhost:8080 /nuxeo/nxpicsfile,
Download
Download size Original j
Download

The system will ask if you want to download those pictures on your desktop.

Sending a link to download the asset

It's possible to send a link to your contact, so that he or she can directly download the asset.

To get the link the person can use to download the asset:

1. Click on the Export tab of the asset.
2. Copy the URL displayed in the tab and send it.

Supported File Formats

The Platform Digital Asset Management module supports a large number of file formats.

Format

Pictures
JPG
PNG
GIF
RAW
JPG2000
TIF
BMP
PSD

Al
EPS/PS
PCX
PICT
SVG
WMF
EMF
QXD
INDD

Video

099

This documentation is published under Creative Common BY-SA license. More details on the Nuxeo Documentation License page.

Import in DAM Mimetype Thumbnail &
recognition preview

X X X

X X X

X X X

X X X

X X X

X X X

X X X

X X X

X

X X

X

X

X

X

X

X

X

X X X (only preview)
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x

20


http://doc.nuxeo.com/x/GATF

NU22ZLe O Nuxeo Digital Asset Management 5.5 Documentation Center

avi (divx, ...) X X X (only preview)

mp4 X X X (only preview)

fiv/fla X X X (only preview)

QT/mov X X** Xx*

mpeg/mpg/mpe X X** Xx

WMV X

swf X

Audio

0ogg X X X (only preview)

mp3 X X X (only preview)

wav X X X (only preview)

m4a/aac X X X (only preview)

ac3 X

aif/aiff/ aifc X

au/snd X

asf X

Office

pdf X X X (only preview) X
Microsoft Office (c) X X X (only preview) X
Open Office X X X* (only preview) X
RTF X X X (only preview) X
Microsoft Access (c) X

Microsoft publisher X

(©)

*Client browser must have the associated plugin installed
** with streaming service enabled

Managing Nuxeo DAM

As a module of the Nuxeo Platform, DAM benefits from all its local and global management features, such as access rights management or
vocabularies management. Local management features are management of folders, while global management features are administration
functionalities that apply to the whole application.

Like on any Nuxeo Platform based application, the management of the application takes place in the Admin Center. The management of DAM
folders is available from the Document Management tab, in the Asset Library domain.

Users & Groups

Only administrators can manage users and groups. They can create new users and groups, modify
their properties or delete them.

It is also possible to connect the Nuxeo Platform to an external directory (LDAP directory for instance).

(D When you use an external directory for users and groups, the actions available on users
and groups are limited, even to administrators.

Users and groups management is available:

® from the Admin Center, in the Users & groups tab,

Copyright © 2010-2016 Nuxeo.
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nuxeo Home Document Management
System information Users | Groups
Activity &)Createanew user

Nuxeo Connect |
Update Center

Monitoring

OAuth / OpenSocial

Users & groups

Vocabularies

Dashboards

Themes

Search

No user matching the entered criteria

DAM | Admin Center | Studio | Administrator v

Clear

® from the Home tab, in the Users & groups tab.
nuxeo Home Documen

Dashboard Users | Croups
[£=] Profile

[~] Notifications

t Management DAM Admin Center | Studio | Administrator ¥

&)Create a new user

Search Clear
Authorized Applications
58 Users & groups
Mo user matching the entered criteria
On this page
® Managing users

® User's parameters

® Creating a user

® Editing a user's properties

® Deleting a user

® Managing groups of users
Groups parameters

® Creating a group

® Editing a group

® Delete a group

Managing users
User's parameters
Field Description
Username Name the user will use to log in.
First Name First name of the user
Last Name Last name of the user
Company Company or organization of the user
Email email of the user.
This address is used for alerts.

Password User's password

Password (Verify)

This documentation is published under Creative Common BY-SA license. More details on the Nuxeo Documentation License page.

User's password
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Groups for this user Groups of which the user is a member.
User must be at least in 'administrators' or ‘members' group, or one of
their sub-groups.

Virtual groups for this user

Avatar Image that represents the user in the application.

Birth date User's birth date

Phone number User's phone number

Gender User's gender. Default value is Male.

Public profile Visibility of the social collaboration information of the user. By default,

profiles are public.

Creating a user

Only administrators can create new users.

By default, the Nuxeo Platform has one user, called Administrator. This user is the administrator. You must use this user to create new users and
delegate them access rights.

(D Users must be at least in "administrators" or "members" group, or one of their sub-groups to be able to access the application's content.

To create a user:

1. Click on the Admin Center main tab, and then on the Users & groups tab.
The members management interface opens on the user directory search form.
2. Click on the Create a new user button.
3. Fillin the user creation form.
Mandatory fields are indicated by a red asterisk.
4. Click on the Save button.
The card of the new user is displayed. You can modify its properties and its password.
The user can immediately connect to the Nuxeo application using his or her username and password.

jdoe
Delete

View Edit Change password

Username jdoe

First name John

Last name Doe

Company Nuxeo

Email jdee@nuxeo.com

Groups for this user
g members

Virtual groups for
this user

Editing a user's properties
Only administrators can modify other users' properties. But every user can modify his own properties from the Profile tab of his Home.

You cannot edit the username, as it is the ID of the user on the application.

Copyright © 2010-2016 Nuxeo.
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jdoe
Delete

View Edit Change password

Username Jjdoe

First name |J0hn |
Last name | Doe |
Company | MWuxeo |
Email * | jdoe@nuxeo.com |

Groups for this user Search for groups

= members
Te start the search, please type at least 3 character(s)

Virtual groups for
this user

Save

When you are using an external directory for users management, the Edit tab is not displayed as you cannot edit the users' properties (managed
directly from the directory).

To modify a user's properties:

1. Click on the Admin Center main tab, and then on the Users & groups tab.
The members management interface opens on the user directory search form.
2. Search a user and click on the user's name to open his or her card.
The user's card is displayed.
. Click on the Edit tab.
. Modify the fields in the modification form.
5. Click on the Save button.
The View tab is displayed with your modifications.

W

Deleting a user

Only administrators can delete users.

(D Deleting a user is a permanent action.

To delete a user:

1. Click on the Admin Center main tab, and then on the Users & groups tab.
The members management interface opens on the user directory search form.
2. Search a user and click on the user's name to open his or her card.
The user's card is displayed.
3. Click on the Delete button.
A window pops up.
4. Click on the OK button.
The user is deleted. He or she cannot log in to the Nuxeo application.

Managing groups of users

Groups of users can be created and their properties modified directly in the Nuxeo Platform. Groups of users are used to manage access rights
more easily. Instead of giving (or denying) access rights to single users and repeat the same operations several times, you can give several users
the same right in one single manipulation by using a group.

There are two default groups in the Nuxeo Platform:

® administrators: the members of this group are administrators of the application. They can manage users, vocabularies and documents.
®* members: the members of this group by default have reading rights on all the content of the application.

Groups can be composed of users and of sub-groups. Sub-group's members automatically become members of the parent group. Thus, they are

Copyright © 2010-2016 Nuxeo.
This documentation is published under Creative Common BY-SA license. More details on the Nuxeo Documentation License page. 24



http://doc.nuxeo.com/x/GATF

nus:

@ 0O Nuxeo Digital Asset Management 5.5 Documentation Center

granted all the access rights you give to the group.

(D Users must be in one of these 2 default groups to be able to access content.

You can create as many groups as needed.

Groups parameters

Field Description
Group name The ID of the group.

The ID cannot be modified.
Group label The name of the group displayed to users.
Group's members Users that belong to the group.
Sub-groups Groups that belong to the group.

Creating a group

Only administrators can create groups of users.

To create a group of users:

1.

g b~ w

Click on the Admin Center main tab, and then on the Users & groups tab.
The directory opens on the Users tab.

. Click on the Groups tab.

A search form and the list of the existing groups is displayed.

. Click on the Create a new Group button.
. Fill in the creation form.
. Click on the Save button.

The View tab of the group's card is displayed.

@ If you need to create several groups, click on the Save and create button.
You group is saved and the group creation form is displayed so you can immediately create another group.

Editing a group

Only administrators can modify groups.

Modifying groups most often consists in adding or removing members of the group. The name of the group cannot be changed.

Copyright © 2010-2016 Nuxeo.
This documentation is published under Creative Common BY-SA license. More details on the Nuxeo Documentation License page.

25


http://doc.nuxeo.com/x/GATF

NU22ZLe O Nuxeo Digital Asset Management 5.5 Documentation Center

members

= Back to the list
¥ Delete

Wiew | Edit
Group label Members group

Group's members  Search for users
& John Doe
8 John Smith

To start the search, please type at least 3 character(s) 2 Marge White

X X X X

4% Clark Parker

Sub-groups  Search for groups
x S5 Project Managers

To start the search, please type at least 3 character(s) x S* Redactors

Save

To edit a group:

1. Click on the Admin Center main tab, and then on the Users & groups tab.
The directory opens on the Users tab.
2. Click on the Groups tab.
A search form is displayed.
3. Search a group and click on its name to open its card.
The card displays the members and sub-groups of the group in the View tab.
4. Click on the Edit tab.
The modification form is displayed.
5. Modify the group's members and click on the Save button.
The View tab of the group is displayed with the modifications you just made.
The new group members are immediately granted the group's access rights. The users who are no longer members of the group are
denied group's access rights. However they still have their individual access rights.

Delete a group

Only administrators can delete groups.
To delete a group:

1. Click on the Admin Center main tab, and then on the Users & groups tab.
The directory opens on the Users tab.
2. Click on the Groups tab.
A search form is displayed.
3. Search the group to delete and click on its name to open its card.
The card displays the members and sub-groups of the group in the View tab.
4. Click on the Delete button.
A window pops up.
5. Click on the OK button.
The group search form is displayed. The group is displayed and its members lose the group's access rights.

Managing access rights

Access to documents and the actions allowed are determined by access rights on the DAM folders
(import folders, import sets, folders inside import sets). Some users will then be allowed to only read
documents, when others will be able to edit documents or to manage folders and documents. The
management of the access rights is done from the Document Management tab of the application, in
the Asset Library domain that contains the DAM folders.

Managing access rights means granting or denying access rights in a space. The access rights
management screen is available as a sub-tab in the Manage tab of the space.

The access rights management sub-tab is accessible composed of three parts:
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Content  Edit  Manage

Access rights | Local configuration Trash

Inherited rights

WoR Username Granted parmissions Denied parmissions
2 Adminisratar Manage everything
E- Members group Read

Block permissiens inheritance

Local rights

Type Usermame Granfed permissions Denled permissions

:p Johin Doe Marage sverything Write

Add a new security rule

Search for users or groups Action Crant ﬂ

Permission g -
Ta start the search, please type at least 3 characien(s) Etad I

Add permission

1. the Inherited rights part displays rights that were granted or denied in a parent space;
2. the Local rights part displays the rights that were granted or denied in the current space;
3. the form to grant or deny access rights in the current space.

On this page
® The DAM permissions
® Granting access rights
® Denying access rights
® Removing a user from local rights
® Blocking rights inheritance
The DAM permissions
The DAM access rights are:
Right Actions in DAM
Read Consult content

Comment documents
Annotate documents

Write Import documents
Edit documents
+ Read actions

Everything Manage access rights
+ Write and Read actions

Remove Delete documents

@ The Remove permission is most intended to be denied, so
as to restrict the actions available to users with “Write"
permission.

As you can see, some rights include more permissions than others, and sometimes include other rights. That's the case for "Write", that includes
"Remove".

Beside the fact that some rights are stronger than others, you should be aware, when you set up rights on a space, that some rights have priority
over others:

® J|ocal rights have priority over inherited rights,
® granted rights have priority over denied rights.
The fact that the rights are given or denied to a single user or a group doesn't have any influence.
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Access rights are given on folders and are inherited by all the assets of a folder.

(D By default, members are all granted "Read" permission at the application's root by default. As a consequence, they can see all the
assets of the application.

Granting access rights

To grant access rights to a folder:
Prerequisite: In the Document Management tab, browse the Asset library domain to the space (import folder, import set, folder...) you want to

grant access to.

1. Click on the Manage tab of the space.
The Access Rights sub-tab is displayed.
2. In the form, type the username of the user you want to grant rights to.

To give access rights to a group, type the group's name.
The names of the users or groups corresponding to the typed characters are automatically displayed as you type.

Search for users or groups
JUh"I|

Ebjohn Doe
&John Smith

3. Click on the user you want to give access rights to.
4. Select the right to grant in the Permission drop down list.

Action | crant |
Permission | wiite ~|

Add permission

5. Click on the Add permission button.
The user and its rights are displayed in the Local Rights part of the screen.

Local rights =
Type Username Granted permissions Denied permissions
£ John Doe Write

Save local rights

6. Save local rights modification by clicking on the Save local rights button.
Local rights are saved and applied.

Denying access rights

If a user has inherited rights that you don't want him to have in the current folder, you can deny him these rights. If you want to deny access rights
to a large number of users, block rights inheritance and give access rights only to the users you want to be able to access the workspace or

section.

To deny access to a folder:

Copyright © 2010-2016 Nuxeo.
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Prerequisite: In the Document Management tab, browse the Asset library domain to the space (import folder, import set, folder...) you want to
refuse access to.

1. Click on the Manage tab of the space.
The Access Rights sub-tab is displayed.
2. In the form, type the username of the user you want to grant rights to.
To deny access rights to a group, type the group's name.
The usernames corresponding to the typed characters are automatically displayed.

Search for users or groups
john|

Eﬁ]ohn Doe
& john smith

3. Click on the user you want to deny rights to.
4. Select the right to deny in the Permission drop down list.
5. Click on the Add permission button.
The user is in the Local rights form. The denied rights is displayed in the Denied permissions column.

Local rights -
Type Username Granted permissions Denied permissions
& John Dee Write Remove

Save local rights

6. Save local rights modification by clicking on the Save local rights button.
Local rights are saved and applied.

Removing a user from local rights

If you want to refuse rights to a user, and that these rights have been granted in the current space (import folder, import set, folder...), you can
remove the user from the space's local rights.

To remove a user from a folder's local rights:

Prerequisite: In the Document Management tab, browse the Asset library domain to the space (import folder, import set, folder...) you want to
change the access to.

1. Click on the Manage tab of the space.

The Access Rights sub-tab is displayed.
2. Inthe Local Rights part of the screen, check the box corresponding to the user you want to remove.
3. Click on the Remove permission(s) button.

The user is removed from the Local Rights table.

Local rights

Mo local rights are defined on the current document

Save local rights

4. Save local rights modification by clicking on the Save local rights button.
Local rights are saved and applied.

Blocking rights inheritance

The rights that are granted or denied in a space are applied to the space's content, including its sub-spaces. You thus have the same rights in the
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sub-spaces as in the parent space. For instance, the rights applied in an import folder are also applied to all the import sets inside it. This is called
rights inheritance.

You can block this inheritance. It enables you to block the access of a sub-folder to the folder's users, for instance, or to deeply modify the access
rights in the sub-folder.

To block rights inheritance:

1. Click on the Manage tab of the space of which you want to the access rights.
The Access Rights sub-tab is displayed.

2. Check the box Block permissions inheritance located under the Inherited Rights table.
The inherited rights table is not displayed anymore.

Inherited rights

[Q] Block permissions inheritance
Mo rights are inherited from parent documents

You are added in the list of the local rights, like the administrators group.

Local rights
Type Username Granted permissions Denied permissions
& Administrators group Manage everything
8 John Doe Manage everything

In the Access Rights tab of the possible sub-spaces, a group Everyone is denied all rights.

Inherited rights

Type Username Granted permissions Denied permissions
= Administrators group Manage everything
P John Doe Manage everything
=y Everyone Manage everything

Block permissions inheritance

You can now grant access rights to users.
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